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1. Програма навчальної дисципліни «Веб-технології в науково-
дослідній діяльності». 

Опис предмета навчальної дисципліни 
Предмет: веб-технології  

Характеристика 
навчальної дисципліни 

Курс: 
підготовка 
бакалаврів 

 

Напрям, спеціальність, 
освітньо-кваліфікаційний 

рівень Денне відділення 
Кількість 
кредитів, 
відповідних 
ECTS: 4 
Загальна кількість 
годин – 120 
Тижневих годин – 
4 
 

Шифр та назва напряму: 
0201 Культура і мистецтво 
Шифр та назва 
освітньої програми: 
029. «Інформаційна, 
бібліотечна та архівна 
справа» 

Обов’язкова 
Рік підготовки: 1 
Семестр: 2 
Лекції (теоретична 
підготовка): 4 год. 
Практичні: 56 год. 
Самостійна робота: 60 
год. 
Вид контролю: залік 
(2 семестр) 

Примітка. Співвідношення кількості годин аудиторних занять до 
самостійної й індивідуальної роботи для денної форми навчання 
становить – 60/60, для заочної форми навчання – 30/90 

 
Мета і завдання навчальної дисципліни 

Мета навчальної дисципліни – ознайомлення аспірантів із засобами 
та підходами до ведення наукової діяльності в сучасному середовищі 
глобальної мережі Інтернет. 

Серед загальних компетентностей, які формуються в процесі вивчення 
навчальної дисципліни: 
– здатність до абстрактного мислення, аналізу та синтезу; 
– здатність застосовувати знання у практичних ситуаціях; 
– знання та розуміння предметної області та професійної діяльності; 
– здатність до письмової та усної комунікації державною та іноземною 

мовами; 
– навички використання інформаційних і комунікативних технологій; 
– здатність до пошуку та опрацювання та аналізу інформації з різних 

джерел; 
– здатність приймати обґрунтовані рішення не лише в стандартних, але й 

непередбачуваних виробничих ситуаціях; 
– здатність оцінювати та забезпечувати якість виконуваних робіт; 
– здатність працювати в команді; 
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– здатність спілкуватися з представниками інших професійних груп 
різного рівня (з експертами з інших галузей знань/видів економічної 
діяльності). 
Серед професійних компетентностей: 

– здатність використовувати конструктори комбінаторних пошукових 
запитів наукової інформації; 

– здатність працювати з мережевими науковими ресурсами, 
репозитаріями, базами даних, електронними бібліографічними 
менеджерами; 

– здатність використовувати системи антиплагіату та їх базові 
характеристики; 

– здатність створювати цифрові публікації, здійснювати самоархівування 
у ресурсах відкритого доступу; 

– здатність застосовувати веб-платформи для проведення емпіричних 
досліджень; 

– здатність використовувати семантичні технології у науково-
дослідницькій діяльності; 

– здатність створювати та координувати віртуальні предметні спільноти 
на базі сучасних веб-технологій. 
Очікувані результати навчання з дисципліни «Веб-технології 

в науково-дослідній діяльності»: 
– володіти конструкторами сайтів, блогів, блог-квестів; 
– уміти використовувати хмарні сервіси, сервіси створення інтелект-карт; 
– уміти застосовувати платформи проведення вебінарів, веб-конференцій, 

сервісів цифрової публікації; 
– уміти використовувати наукові веб-проекти, соціальні наукові мережі, 

проекти цифрових лабораторій; 
– уміти аналізувати індекси цитування та інші наукометричні показники 

вченого, наукових організацій, колективів, імпакт-фактори журналів; 
– мати навички моделювання процесу взаємодії з організаторами 

наукових проектів; 
– використовувати єдиний міжнародний реєстр вчених ORCID. 

 
Підсумковий контроль засвоєння знань здійснюється у формі 

заліку. Передбачені рубіжні етапи контролю знань у формі усного 
опитування, виконання практичних завдань та самостійної роботи, 
тестування. 
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ТЕМАТИЧНИЙ ПЛАН КУРСУ 
(денне відділення) 

Кількість годин 

 № 
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1 2 3 4 5 6 7 8 
Розділ 1. Робота з пошуковими системами наукової інформації 

1. Пошукові системи наукової 
інформації: поняття, 
особливості їх використання 

11 1 - 4 6 перевірка 
практ. р. і 
с/р, тест  

Розділ 2. Знайомство з технологіями публікаційної активності 
2. Підходи до аналізу 

публікаційної активності 
вченого, шляхи ії підвищення 

39 1 - 20 18 перевірка 
практ. р. і 
с/р, тест 

Розділ 3. Створення веб-портрета вченого, робота з індексами 
цитування, імпакт-факторами наукових журналів 

3. Веб-портрет вченого: підходи 
до створення портрету, підходи 
по опису публікацій 

25 1 - 12 12 перевірка 
практ. р. і 
с/р, тест 

Розділ 4. Моделювання процесу взаємодії аспірантів та організаторів 
наукових заходів у веб-середовищі: веб-аспекти 

4. Особливості наукової взаємодії 
у веб-середовищі зі створенням 
та використанням віртуальних 
предметних спільнот 

45 1 - 20 24 перевірка 
практ. р. і 
с/р, тест 

 Разом 120 4 - 56 60 Залік 
 

(заочне відділення) 
Кількість годин 

 № 
п/п 

 
Назва розділів, тем 

ус
ьо

го
 

ле
кц

ій
 

се
мі

на
р.

 
за
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тт

я 
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т. 

ра
б.
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м.
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. 
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а 
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1 2 3 4 5 6 7 8 
Розділ 1. Робота з пошуковими системами наукової інформації 

1. Пошукові системи наукової 
інформації: поняття, 
особливості їх 
використання 

21 1 - 4 16 перевірка 
практ. р. і 
с/р, тест 
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Розділ 2. Знайомство з технологіями публікаційної активності 
2. Підходи до аналізу 

публікаційної активності 
вченого, шляхи ії 
підвищення 

35 1 - 6 28 перевірка 
практ. р. і 
с/р, тест 

Розділ 3. Створення веб-портрета вченого, робота з індексами 
цитування, імпакт-факторами наукових журналів 

3. Веб-портрет вченого: 
підходи до створення 
портрету, підходи по опису 
публікацій 

31 1 - 8 22 перевірка 
практ. р. і 
с/р, тест 

Розділ 4. Моделювання процесу взаємодії аспірантів та організаторів 
наукових заходів у веб-середовищі: веб-аспекти 

4. Особливості наукової 
взаємодії у веб-середовищі 
зі створенням та 
використанням віртуальних 
предметних спільнот 

33 1 - 20 24 перевірка 
практ. р. і 
с/р, тест 

 Разом 120 4 - 26 90 Залік 
 

Зміст курсу 
Предмет, структура, завдання курсу. Місце курсу в професійній 

підготовці докторів філософії. Зв’язок з дисциплінами «Організація та 
методика НДР», «Наукометричні бази даних», «Менеджмент знань» та 
іншими. Теоретична спрямованість курсу. Форми навчальної роботи. 
Інформаційно-бібліографічне забезпечення дисципліни. 

 
Розділ 1. Робота з пошуковими системами наукової інформації. 

  
Тема 1. Пошукові системи наукової інформації: поняття, 

особливості їх використання. 
Пошукові системи наукової інформації: Scientopica, e-Print ArXive, 

Google Scholar, Infotrieve – artical finder, HighWire Press, Science Research 
Portal, Scirus. Основні характеристики пошукових систем наукової 
інформації. Scientopica – розвинута наукова пошукова система та каталог 
наукових ресурсів. E-Print ArXive – архів електронних публікацій, доступ 
до статей з computer science та ін. Вільний обмін науковою інформацією. 
Google Scholar – пошукова система наукової інформації, включає статті 
великих наукових видавництв, архіви препринтів, публікації на сайтах 
університетів, наукових товариств та інших наукових організацій. Індекс 
цитування публікацій Google Scholar. Infotrieve – artical finder – пошук 
статей в більш ніж 35000 журналах з фізики, техніці, медицині, 
юриспруденції та ін.; надає можливість шукати тільки з якоїсь певної 
галузі науки, переглядати анотації. HighWire Press – сховище наукових 
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журналів, що надають безкоштовний повнотекстовий доступ до своїх 
статей. Science Research Portal – наукова пошукова система, що здійснює 
повнотекстовий пошук у журналах багатьох великих наукових видавництв 
(Elsevier, Highwire, IEEE, Nature, Taylor & Francis та ін.). Пошук статей та 
документів у відкритих наукових базах даних: Directory of Open Access 
Journals, Library of Congress Online Catalog, Science.gov і Scientific News. 
Scirus – універсальна наукова пошукова система, яка здійснює 
повнотекстовий пошук по статтях журналів великих іноземних 
видавництв, статтям у великих архівах, іншим науковим ресурсам Internet.  

Практичне заняття. Порівняльна характеристика пошукових 
систем наукової інформації – 4 год. 

Самостійна робота: Пошук зарубіжних публікацій за темою 
дисертаційного дослідження –  6 год. 

 
Розділ 2. Знайомство з технологіями публікаційної активності. 

 
Тема 2. Підходи до аналізу публікаційної активності вченого, 

шляхи ії підвищення. 
Особливості наукометричних та бібліометричних методів оцінки 

публікаційної діяльності вченого. Сильні та слабкі сторони 
наукометричного інструментарію оцінки наукового потенціалу. Шляхи 
підвищення власних індивідуальних наукометричних показників: 
публікація у співавторстві з колегами, які мають високі наукометричні 
показники, включаючи іноземних колег-учених; самоцитування; 
створення якісних резюме до статей українською та англійською мовами з 
вживанням загальноприйнятої у світовій практиці термінології; відбір 
ключових слів, з використанням загальноприйнятих термінів, відстеження 
якості перекладу; особливості присвоєння ключових слів. Вибір сервісів та 
веб-платформ для публікації, апробовування та обговорення результатів 
наукових досліджень у веб-середовищі. 

Виявлення сучасних тенденцій в науці. Оцінка результатів наукових 
досліджень на основі публікаційної активності. Визначення кола експертів 
певної наукової галузі. Пошук найперспективніших наукових проектів та 
залучення до них. 

Практичне заняття. Розбудова віртуального профілю науковця – 
4 год. 

Практичне заняття. Створення веб-портрета вченого – 4 год. 
Самостійна робота: Розбудова власного веб-портрета молодого 

вченого  – 6 год. 
Практичне заняття. Створення ORCID профілю – 4 год. 
Самостійна робота: Розбудова власного профілю ORCID – 6 год. 
Практичне заняття. Створення профілю в Google Scholar – 4 год. 
Самостійна робота: Аналіз Google Scholar-профілів провідних 

науковців галузі – 6 год. 
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Практичне заняття. Робота з проектом «Бібліометрика української 
науки» – 4 год. 

 
Розділ 3. Створення веб-портрета вченого, робота з індексами 

цитування, імпакт-факторами наукових журналів. 
 

Тема 3. Веб-портрет вченого: підходи до створення портрету, 
підходи по опису публікацій. 

Персональний веб-портрет вченого, його представництво в мережі 
Інтернеті. Організаційні та технічні аспекти створення та подальшої 
підтримки персонального сайту, персональної сторінки, контент 
розміщуваних відомостей про вченого. 

Розбудова віртуального профілю науковця. Оптимізація унікальних 
профілів дослідника в популярних спеціалізованих наукових сервісах. 

Особливості використання авторських ідентифікаторів Open 
Researcher and Contributor ID, Open Researcher. Використання Web of 
Knowledge, Researcher ID и Endnote Web. Особливості застосування веб-
платформ для створення портрету вченого: Google Scholar, Scipeople.ru, 
Science-community.org тощо. Використання соціальних медіа для 
популяризації результатів науково-дослідної роботи, «бренду» наукової 
школи, установи, колективу, вченого. Поняття блог-квесту та 
особливості використання цієї технології у науково-дослідній діяльності. 

Практичне заняття. Дослідження наукометричних та 
бібліометричних методів оцінки публікаційної діяльності вчених – 
4 год. 

Практичне заняття. Аналіз публікаційної активності вченого – 
4 год. 

Самостійна робота: Аналіз публікаційної активності відомих 
науковців галузі – 6 год. 

Практичне заняття. Робота з індексами цитування – 4 год. 
Самостійна робота: Аналіз кореляції між наукометричними 

показниками та даними альтметрікс публікацій за темою дисертації – 
6 год. 

 
Розділ 4. Моделювання процесу взаємодії аспірантів та 

організаторів наукових заходів у веб-середовищі: веб-аспекти. 
 
Тема 4. Особливості наукової взаємодії у веб-середовищі зі 

створенням та використанням віртуальних предметних спільнот. 
Створення та координування віртуальних предметних спільнот на базі 

веб-технологій. Особливості організації веб-конференцій, проведення 
вебінарів, майстер-класів: огляд технологій та сервісів. Застосування 
колаборативних сервісів під час проведення спільних наукових 
досліджень. Інструментарій для організації відкритого наукового 
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співробітництва. Інформаційні ресурси для наукових досліджень. 
Створення інтелект-карт. 

Використання соціальних мереж для дослідників (ResearchGate, 
Academia.edu та ін.), що дають можливість ділитися статтями, 
відстежувати їх цитованість, слідкувати за новими публікаціями науковців 
тощо. Сервіси Алтметрикс. Інструментарій для співпраці вчених у веб-
середовищі. Обмін повними текстами наукових документів, участь 
у фахових дискусіях. Робота з системами антиплагіату.  

Практичне заняття. Створення та координація віртуальних 
предметних спільнот – 4 год. 

Практичне заняття. Використання соціальних мереж для 
науковців – 4 год. 

Самостійна робота: Порівняльна характеристика функціоналів 
соціальних мереж для науковців – 6 год. 

Практичне заняття. Робота з сервісами Аltmetric – 4 год. 
Самостійна робота: Порівняльна характеристика ресурсів, що 

пропонують дані альтметрікс – 6 год. 
Практичне заняття. Створення інтелект-карт – 4 год. 
Самостійна робота: Розробка інтелект-карт підрозділів власного 

дисертаційного дослідження – 6 год. 
Практичне заняття. Створення наукового блог-квесту – 4 год. 
Самостійна робота: Опанування бібліографічного менеджеру 

Mendeley – 6 год. 
 
2. МЕТОДИЧНІ РЕКОМЕНДАЦІЇ ДО ПРАКТИЧНИХ ЗАНЯТЬ, 

САМОСТІЙНОЇ РОБОТИ СТУДЕНТІВ. 
 

Розділ 1. Робота з пошуковими системами наукової інформації. 
 

Тема 1. Пошукові системи наукової інформації: поняття, 
особливості їх використання. 

Практичне заняття. Порівняльна характеристика пошукових 
систем наукової інформації – 4 год. 

Мета: отримати навички роботи в пошуковими системами наукової 
інформації. 

Завдання: 
1. Обрати декілька систем пошуку наукової інформації. 
2. Освоїти навички роботи з різноманітними пошуковими системами: 

комбінації ключових і спеціальних слів, логічних операторів тощо. 
3. Скласти інструкцію пошуку інформації, враховуючи суттєві 

недоліки природної мови з точки зору машинної технології обробки 
інформації: різноманіття засобів передачі змісту, контекст, парадигматичні 
відношення між словами; текстуальні відношення між словами; 
семантичну неоднозначність, багатозначність, омонімічність слів. 

4. Записати основні рекомендації з пошуку. 
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5. Результати надати в електронному вигляді. 
Література: 1, 21. 
 
Самостійна робота: Пошук зарубіжних публікацій за темою 

дисертаційного дослідження – 4 год. 
Мета: отримати навички роботи з публікацями зарубіжних фахівців. 
Завдання: 
1. Користуючись пошуковими системами наукової інформації 

здійснити пошук зарубіжних публікацій за темою власного 
дисертаційного дослідження. 

2. Користуючись аналітичною надбудовою Google Scholar, 
враховувати показники цитованості джерел та індексів публікативної 
активності авторів. 

3. Підготувати список джерел для дисертаціної роботи. 
Результати надати в електронному вигляді. 
Література: 1, 3, 30 . 
 

Розділ 2. Знайомство з технологіями публікаційної активності. 
 
Тема 2. Підходи до аналізу публікаційної активності вченого, 

шляхи ії підвищення. 
Практичне заняття. Розбудова віртуального профілю науковця – 

4 год. 
Мета: проаналізувати можливості самопрезентації науковця в 

мережевому просторі. 
Завдання: 
1. Здійснити пошук платформ, що уможливлюють наукову 

комунікацію. 
2. Проаналізувати облікові записи відомих вчених та молодих 

науковців у вітчизняних веб-проектах та на зарубіжних платформах. 
3. Запропонувати перелік сервісів, платформ, соціальних мереж, 

блог-платформ, репозитаріїв та ін., що посилюють можливості 
здійснення наукової комунікації та проведення наукової діяльності. 

Результати надати в електронному вигляді. 
Література: 2. 
 
Практичне заняття. Створення веб-портрета вченого – 4 год. 
Мета: з’ясувати можливості створення веб-портрета вченого. 
Завдання: 
З’ясувати можливості розбудови веб-портрету науковця засобами 

веб-порталів: 
1. Google Scholar: https://scholar.google.com.ua/ 
2. «Український індекс наукового цитування»: 

http://uincit.uran.ua/scientists/fronts/about 
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3. Науковці України: http://irbis-nbuv.gov.ua/cgi-
bin/suak/corp.exe?C21COM=F&I21DBN=SAUA&P21DBN=SAUA 

4. ORCID: orcid.org 
5. ResearcherID: http://www.researcherid.com/ 
6. Impactstory: https://impactstory.org/ 
7. Соціальні мережі: ResearchGate, Academia.edu, Science-community.org. 
8. E-LIS repository: http://eprints.rclis.org/. 
Підготувати звіт. 
Результати надати в електронному вигляді. 
Література: 2. 
 
Самостійна робота: Розбудова власного веб-портрета молодого 

вченого – 6 год. 
Мета: створити веб-портрет молодого науковця. 
Завдання: 
Створити та за необхідності пов’язати між собою: 
1. Профіль в Google Scholar: https://scholar.google.com.ua/ 
2. Профіль ORCID: orcid.org 
3. Профіль ResearcherID: http://www.researcherid.com/ 
6. Профіль в Impactstory: https://impactstory.org/ 
7. Профіль в соціальних мережах для науковців: ResearchGate, 

Academia.edu, Science-community.org. 
8. Профіль E-LIS repository: http://eprints.rclis.org/ 
Література:  1, 2, 15.  
 
Практичне заняття. Створення ORCID профілю – 4 год. 
Мета: створити ORCID профіль. 
Завдання: 
1. Перейти на сайт за адресою: https://orcid.org/. 
2. Ознайомитись з некомерційним проектом ORCID, умовами 

існування співтовариства науковців, університетів, національних 
дослідницьких лабораторій, комерційних дослідницьких організацій, 
спонсорів досліджень, видавців, національних наукових агентств та ін. 

3. Зайти в розділ «For researchers» і там натиснути посилання 
«Register for an ORCID iD». 

3. Заповнити поля реєстраційної форми: 
– First name 
– Last name 
– Email 
– Re-enter email (Повторне введення email) 
– Password (Пароль) 
– Confirm password (Повторне введення пароля) 
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– Default privacy for new works (Рівень приватності, що буде 
використовуватися для нових робіт): Public (Загальнодоступний), 
Limited (Обмежений), Private (Особистий). 

– Send me notifications about changes to my ORCID Record (Посилати 
повідомлення на email про зміни в моєму профілі ORCID). 

– Send me information about events ORCID is sponsoring and ORCID news 
(Посилати мені інформацію про події, що спонсоруються ORCID, а 
також новини ORCID). 

– I consent to the privacy policy and terms and conditions of use, including 
allowing those who access the database to make commercial uses of the 
public data (Я згоден з угодою про конфіденційність, а також з 
постановами і умовами використання, що включають доступ до бази 
даних з метою комерційного використання загальнодоступних 
даних). 
4. Натиснути кнопку «Register». 
5. Після присвоєння особистого ORCID iD перейти на сторінку свого 

профілю в ORCID. Номер ORCID знаходиться в лівій панелі, під Вашим 
ім'ям. 

6. Ознайомитись з можливостями створення ORCID для 
спонсорських організацій, видавців, професійних асоціацій, дослідних 
організацій університетів, дослідницьких компаній, національних 
дослідницьких лабораторій і членських організацій тощо). 

7. Ознайомитись з функціоналом порталу. 
Література: 35. 
 
Самостійна робота: Розбудова власного профілю ORCID – 6 год. 
Мета: завершити створення профілю ORCID. 
Завдання: 
1. Увійти в профіль ORCID. 
2. Додати інформацію про себе. Для редагування та додавання 

персональних даних натиснути посилання «Update» у рядку «Personal 
Information». 

3. У вікні Ви можете відредагувати або додати наступну інформацію: 
– First Name (Ім'я). 
– Last Name (Прізвище). 
– Published Name (Як Ваше ім'я буде записуватися в тому числі в 

профілі ORCID). 
– Other Names (Інші імена, які Ви використовуєте. Наприклад, з 

дівочим прізвищем. Можна записати кілька варіантів через крапку з 
комою). 

– Biography (Біографія. Короткий опис Вашої професійної кар'єри). 
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– Keywords (Ключові слова, які описують Вашу наукову діяльність. 
Вказати через точку з коми). 

– Country (Країна, в якій Ви працюєте). 
– Website (Короткий опис і URL. Можна додати кілька посилань на 

вебсайти: особистий вебсайт, сайт організації, сторінку в Wikipedia 
або посилання на профілі в соціальних мережах Facebook, Twitter, 
Google+, LinkedIn та ін.). 

– Email Address (Якщо Ви зміните Email, далі Ви будете входити в свій 
профіль ORCID під новим Email. Після зміни буде надіслано 
повідомлення на цей email для його підтвердження). 
Для ряду полів Ви можете вказати Рівень приватності. Після 

внесення змін до потрібні поля натисніть кнопку «Save changes». 
4. Для додавання, редагування, видалення публікацій зі списку робіт і 

зміни їх рівня приватності натисніть посилання «Update» у рядку 
«Works». 

У вікні, Ви можете вибрати Ваші публікації з результатів пошуку в 
CrossRef. Для додавання Ваших публікацій просто клацніть на назву 
роботи в лівій частині вікна. Таким чином публікації перемістяться в 
список робіт Вашого профілю ORCID. Після цього натисніть кнопку 
«Save changes». 

5. Також Ви можете додати посилання на публікації вручну. Для 
цього у вікні редагування списку робіт натисніть кнопку «Add manually». 

Поля для заповнення: 
Title (Заголовок) 
Subtitle (Підзаголовок) 
Citation (Повний список цитованої літератури) 
Citation Type (Використовуваний тип цитування) 
Work type (Тип публікації) 
Pub Date (Дата публікації. Можна вказати тільки рік або рік і місяць) 
ID (Зовнішній ID публікації, якщо є. Наприклад, DOI або PMID) 
ID type (Формат зовнішнього ID) 
URL (Зовнішнє посилання до публікації) 
Role (Ваша роль в цій публікації) 
Credited (Ви є першим (First) або додатковим (Additional) автором 

публікації) 
Description (Опис публікації. Якщо використовується це поле, то поле 

з цитуванням відображатися не буде) 
Після заповнення форми натисніть кнопку «Add to list». 
Зверніть увагу, що Ви можете змінювати рівень приватності у кожної 

публікації в правій колонці. 
6. Ви можете імпортувати свої публікації з інших сайтів. Наприклад, 

з бази даних Scopus. 
Література: 35. 
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Практичне заняття. Створення профілю в Google Scholar – 4 год. 
Мета: отримати навички роботи з наукометричною функцією Google 

Scholar та створити індивідуальний профіль. 
Завдання: 
1. Зареєструватись або увійти до облікового запису Google, перейти 

до стартової сторінки Google Scholar. 
2. Натиснути на посилання «Мої цитати» 

(scholar.google.com.ua/citations) у верхній частині головної сторінки 
пошуку в Google Академії та пройти запропоновані системою кроки 
реєстрації: вказати ім'я та прізвище, надати інформацію про 
приналежність до установи (назва установи, місто, країна), сферу 
наукових інтересів (до п'яти ключових слів). Для поліпшення видимості 
профілю інформацію можна подавати різними мовами. 

У полі «Електронна адреса для підтвердження» слід указати 
академічну адресу електронної пошти. При використанні неакадемічних 
поштових скриньок можуть виникати проблеми з підтвердженням і 
профіль не буде видимим у результатах пошуку. 

3. Серед запропонованих документів, які були індексовані Google 
Академією, написаних авторами з іменами, схожими на ім'я автора 
профілю, знайти власні та додати їх до профілю – поставити позначки 
біля потрібних статей і натиснути кнопку «Додати». У Вас залишається 
можливість редагувати, видаляти й додавати нові статті у своєму 
профілі. 

4. Обрати спосіб оновлення профілю: автоматично чи після 
підтвердження автором – система надсилає лист для перегляду й 
підтвердження оновлень. 

5. Завантажити фото автора. 
6. Підтвердити авторство профілю через електронну пошту. 
7. Перевірити та доповнити перелік документів у профілі. 
8. За умовчанням перелік публікацій у профілі автора буде 

відсортований за кількістю цитувань. Щоб відсортувати список за датою 
публікації, слід натиснути «Рік», за абеткою – «Назва» у верхній частині 
таблиці. 

У профілі науковця автоматично укладається діаграма кількості 
цитувань документів автора за роками й обраховуються два 
наукометричні показники – h-індекс та i10-індекс. 

Література: 1, 35. 
 
Самостійна робота: Аналіз Google Scholar-профілів провідних 

науковців галузі – 6 год. 
Мета: закріпити навички роботи з Google Scholar. 
Завдання: 
1. Увійти у профіль Google Scholar та здійснити пошук за темою 

власного дисертаційного дослідження. 
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2. Встановити найбільш цитовані роботи за темою дослідження. 
3. Дослідити профілі авторів-науковців та колективів, які працюють 

над проблематикою, спорідненою темі вашого дослідження та мають 
найвищій індекс цитувань; 

4. Результати пошуку зберегти у бібліотеці профілю. 
5. Скласти список джерел, що буде використано у дисертаціному 

досліджені. 
Література: 1, 35. 
 
Практичне заняття. Робота з проектом «Бібліометрика 

української науки» – 4 год. 
Мета: отримати навички роботи з наукометричною надбудовою 

проекту «Бібліометрика української науки». 
Завдання: 
1. Перейти за посиланням http://www.nbuviap.gov.ua/bpnu/ до проекту 

«Бібліометрика української науки». 
2. Ознайомитись з функціоналом проекту. 
3. Здійснити пошук інформації про себе, про установу, аспірантом 

якою ви є, про наукові колективи цієї установи. Встановити рейтингові 
показники. 

4. У розділі «Аналітика» відслідкувати рейтинги вчених, наукових 
колективів та установ відповідної галузі. 

5. Здійснити аналіз профілів науковців, що праціюють за тематикою, 
спорідненою темі вашого дисертаційного дослідження. Доповнити 
список джерел для власного дослідження. 

Література: 3, 44. 
 

Розділ 3. Створення веб-портрета вченого, робота з індексами 
цитування, імпакт-факторами наукових журналів. 

 
Тема 3. Веб-портрет вченого: підходи до створення портрету, 

підходи по опису публікацій. 
Практичне заняття. Дослідження наукометричних та 

бібліометричних методів оцінки публікаційної діяльності вчених – 
4 год. 

Мета: ознайомитись з методами оцінки публікаційної діяльності. 
Завдання: 
1. Користуючись ресурсами платформи «Google Академія» 

(https://scholar.google.com) встановити наявність наукометричних 
профілів науковців, що працюють на факультеті соціальних комунікацій 
(напрям «Інформаційна, бібліотечна та архівна справа»). 

2. На основі аналізу наукометричних профілів науковців скласти 
рейтинг за такими параметрами: 

- загальна кількість цитувань наукових робіт вчених, 
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- h-індекс, 
- і10-індекс, 
- кількість робіт у профілі, що були процитовані. 
Результати оформити у вигляді таблиці: 
 

П.І.Б. 
науковця 

Загальна 
кількість 
цитувань 

наукових робіт 

H-індекс І10-індекс 
Кількість робіт у 
профілі, що були 

процитовані 

 1.         
 
3. Простежити взаємозв'язок між отриманими даними. 
4. На основі аналізу наукометричних профілів науковців скласти 

рейтинг 10 найчастіше цитованих джерел. Наприклад, 
 

№ БО джерела Кількість цитувань 
 1. Шейко В. М., Кушнаренко Н. М. Організація та 

методика науково-дослідницької діяльності : 
підручник. К. : Знання-прес. 2002. 295 с. 

306  

 
5. Зробити висновок відносно отриманих результатів. 
Результати надати в електронному вигляді. 
Література: 30. 
 
Практичне заняття. Аналіз публікаційної активності вченого – 

4 год. 
Мета: отримати навички аналізу публікаційної активності вченого. 
Завдання: 
1. Визначити основний перелік веб-інструментів, що дозволяють 

здійснювати аналіз публікаційної активності вчених.   
2. Здійснити порівняльний аналіз обраних інструментів, визначити їх 

переваги та недоліки. 
3. Підготувати звіт. Результати надати в електронному вигляді. 
Література: 1, 2, 3, 7. 
 
Самостійна робота: Аналіз публікаційної активності відомих 

науковців галузі – 6 год. 
Мета: закріпити навички аналізу публікаційної активності вчених. 
Завдання: 
1. Використовуючи веб-платформи, здійснити аналіз публікаційної 

активності вчених відповідної галузі знань.   
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2. Скласти список вчених, що підготували найбільш цитовані роботи 
за темою дисертації. Визначити аспекти та терміни проведення 
досліджень.  

Література: 15.  
 
Практичне заняття. Робота з індексами цитування – 4 год. 
Мета: проаналізувати можливості роботи з індексами цитування. 
Завдання: 
1. Скласти перелік систем та платформ, що умовливлюють 

оцінку роботи дослідників і наукових колективів. 
2. Визначити особливості національних індексів цитування. 
3. Скласи перелік міжнародних систем цитування (бібліографічних 

баз). 
Результати надати в електронному вигляді. 
Література: 1, 2, 3, 6, 7, 12. 
 
Самостійна робота: Аналіз кореляції між наукометричними 

показниками та даними альтметрікс публікацій за темою дисертації – 
6 год. 

Мета: проаналізувати особливості роботи з наукометричними 
системами та інструментами альтметрікс.  

Завдання: 
1. Користуваючись системами, що дозволяють отримати 

наукометричні показники, та сервісами альтметрікс порівняти показники 
цитованості 20 публікацій вітчизняних та зарубіжних вчених за темою 
дисертації. 

2. Визначити переваги наукометричних систем та сервісів 
альтметрікс. Вказати на ефективність, встановити кореляцію між ними. 

3. Підготувати звіт. 
Література: 15.  
 

Розділ 4. Моделювання процесу взаємодії аспірантів та 
організаторів наукових заходів у веб-середовищі: веб-аспекти. 
 
Тема 4. Особливості наукової взаємодії у веб-середовищі зі 

створенням та використанням віртуальних предметних спільнот. 
Практичне заняття. Створення та координація віртуальних 

предметних спільнот – 4 год. 
Мета: проаналізувати можливості розвитку віртуальних предметрих 

спільнот. 
Завдання: 
1. Здійснити пошук веб-платформ, що дозволяють створювати 

віртуальні спільноти для науковців. Скаласти докладний перелік із 
зазначенням переваг та недоліків. 

2. Створити облікові записи та розпочати наукову дискусію. 
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3. Підготувати звіт щодо ефективності віртуальних предметних 
спільнот. 

Результати надати в електронному вигляді. 
Література: 1, 2, 3, 6, 7, 12. 
 
Практичне заняття. Використання соціальних мереж для 

науковців – 4 год. 
Мета: отримати навички роботи з науковим контентом в соціальних 

медіа. 
Завдання: 
1. Зареєструватись у соціальних мережах для науковців (3-4 на 

власний вибір): Researchgate.net, Academia.edu, Social Science Research 
Network, Myexperiment.org, Ukrainian Scientists Worldwide, Science-
community.org. 

2. Ознайомитись з функціоналом мереж, здійснити порівняльний 
аналіз. 

3. Обгрунтувати яке значення для наукової практики мають 
професійні та мультидисциплінарні соціальні мережі для вчених. 
Визначити переваги та недоліки взаємодії науковців засобами соціальних 
мереж, блог-платформ, тематичних форумів тощо. 

4. Результати надати в електронному вигляді. 
Література: 15. 
 
Самостійна робота: Порівняльна характеристика функціоналів 

соціальних мереж для науковців – 6 год. 
Мета: отримати навички роботи з науковим контентом в соціальних 

медіа. 
Завдання: 
1. Зареєструватись у соціальних мережах для науковців: 

Researchgate.net, Academia.edu, Social Science Research Network, 
Myexperiment.org, Ukrainian Scientists Worldwide, Science-community.org. 

2. Ознайомитись з функціоналом мереж. 
3. Здійснити пошук профілів науковців, наукові інтереси яких 

відповідають тематиці власного дисертаційного дослідження. 
4. Здійснити пошук інформації щодо проведення наукових форумів, 

конференцій тощо. 
5. Скористатись можливістю розміщення та пошуку наукових 

публікацій. 
6. Визначити переваги використання сервісів альтметрікс. 
7. Здійснити порівняльний аналіз функціоналів соціальних мереж та 

підготувати звіт. 
Література: 15. 
 
Практичне заняття. Робота з сервісами Аltmetric – 4 год. 
Мета: отримати навички роботи з сервісами алтметрикс. 
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Завдання: 
1. Ознайомитись з особливостями роботи сервісів алтметрикс 

Altmetric.com, Plum Analytics, ImpactStory, Kudos в соціальних медіа для 
науковців. 

2. Визначити переваги та недоліки їх використання у науковій 
діяльності з точки зору статистики переглядів, поширення інформації 
про наукові документи, отримання показників використання документів 
у сервісах соціальних закладок (наприклад, CiteULike, Mendeley) тощо. 

3. Підготувати звіт. 
Результати надати в електронному вигляді. 
Література: 15. 
 
Самостійна робота: Порівняльна характеристика ресурсів, що 

пропонують дані альтметрікс – 6 год. 
Мета: отримати навички роботи з сервісами алтметрикс. 
Завдання: 
1. Здійснити порівняльну характеристику сервісів алтметрикс 

Altmetric.com, Plum Analytics, ImpactStory, Kudos. 
2. З’ясувати можливості визначення метрик статей, профілів 

користувачів, журналів, книг, наборів даних, презентацій, відео, веб-
сторінок та інших дослідних даних, які створюються та/або 
розповсюджуються в мережі Інтернет. 

3. Підготувати звіт. 
Література: 15. 
 
Практичне заняття. Створення інтелект-карт – 4 год. 
Мета: отримати навички створення ментальних карт. 
Завдання: 
1. Ознайомитись з проблематикою створення інтелект-карт. 
2. Ознайомитись з сервісами створення ментальних карт: 
MindMeister: http://www.mindmeister.com/, 
Coggle: https://coggle.it/, 
XMind: https://www.xmind.net/, 
Mind42: https://mind42.com/, 
iMindMap: https://imindmap.com/. 
3. Порівняти функціонал сервісів. 
4. Створити інтелект-карту за проблематикою, запропонованою 

викладачем. 
5. Презентувати результат викладачеві. 
Література: 4. 
 
Самостійна робота: Розробка інтелект-карт підрозділів власного 

дисертаційного дослідження – 6 год. 
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Мета: отримати навички створення ментальних карт. 
Завдання: 
1. Обрати сервіс для створення інтелект-карти. 
2. Створити ментальні карти за матеріалами розділів та підрозділів 

власного дисертаційного дослідження. 
3. Презентувати результат викладачеві.  
Література: 4. 
 
Практичне заняття. Створення наукового блог-квесту – 4 год. 
Мета: сформувати вміння створювати проекти за технологією Веб-

квест та використовувати їх у дослідницькій діяльності. 
Завдання: 
1. Ознайомитись з теорією питання. 
2. Обрати платформу для створення блог-квесту. Можна використати 

будь-яку блог-платформу, яка є в більшості соціальних мереж і яка не 
потребує спеціальних знань для її використання. 

3. Визначити структуру блог-квесту, що може містити: вступ, тему, 
зміст, ролі, посилання на статті в мережі, пости. Також Блог-квест може 
містити декілька тематичних розділів, що містять пости відповідно до їх 
тематики: коментарі читачів: перелік блогів, які автор читає та відвідує; 
гаджети. 

4. Розробити проект блог-квесту за темою власного наукового 
наукового дослідження. 

5. Представити результати в електронному вигляді. 
 
Самостійна робота: Опанування бібліографічного менеджеру 

Mendeley – 6 год. 
Мета: отримати навички роботи з бібліографічнимо менеджером 

Mendeley. 
Завдання: 
1. Створити обліковий запис на сайті соціальної мережі Mendeley 

(http://www.mendeley.com). Базовий пакет Mendeley поширюється як 
безкоштовне програмне забезпечення. 

2. Створити власну бібліотеку: 
Додавати файли в Mendeley, натиснувши на кнопку Add Document на 

панелі інструментів, або просто перетягнувши файли у панель 
документів. Mendeley автоматично намагатиметься визначити 
бібліографічні дані документа. 

Будь-які додані у Mendeley документи потребуватимуть вашої 
перевірки. Використовуйте Document details lookup (CrossRef, PubMed, 
ArXiv), або Google Scholar Search, щоб заповнити порожні поля бібопису 
документа. 
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Також, дані про документ можна отримати за допомогою Google 
Scholar. Введіть правильну назву документа і натисніть кнопку Search by 
Title. Пошук працює лише для імпортованих файлів. 

Mendeley дозволяє легко обмінюватись даними з іншими 
менеджерами бібліографії. Наприклад, для імпорту даних з EndNote™ 
необхідно експортувати бібліотеку у форматі XML. 

У EndNote™: 1. Пункт головного меню File → Export 2. Виберіть тип 
файлу 3. Назвіть файл і збережіть його на комп'ютері Відкриваємо 
Mendeley: 1. Пункт головного меню File → Add Files 2. Оберіть раніше 
збережений файл і натисніть кнопку Open Дані з’являться у Mendeley. 

Синхронізуйте файли з обліковим записом Mendeley Web. 
3. Керувати документами: 
У фільтрі Автори / Теґи / Публікації виділіть неправильний запис і 

перетягніть його на правильний. Наприклад, якщо у вас є два документи 
авторства Aguillo, Isidro F і Aguillo, Isidro F. об’єднайте їх перетягнувши 
перший запис на другий. Підпункт головного меню Tools → Check for 
duplicates дозволяє швидко знайти і об’єднати дублетні записи у Вашій 
бібліотеці. 

При додаванні документів у Mendeley позначаються як непрочитані 
(маленька зелена крапка). Якщо ви відкриєте документ у Mendeley PDF 
viewer він автоматично стає прочитаним. Також можна просто 
перемикати статус прочитано / не прочитано натискаючи на зелену 
позначку. 

Ви можете відзначати ваші улюблені документи. Просто натисніть на 
зірку (ще раз, щоб скасувати). Усі вибрані документи будуть 
відображатися у папці Favorites. 

Ви можете проводити пошук у Mendeley PDF viewer по мірі введення 
пошукових слів, тому Ви швидко знайдете потрібно. Mendeley знайде і 
виділить місця у документів, що задовольняють критерії пошуку. 

Організатор файлів Mendeley значно полегшує роботу з 
документами: допомагає покращити структуру Ваших папок, дозволяє 
автоматично перейменовувати PDF-файли, знаходити документи поза 
Mendeley. Ви можете знайти його тут: Tools → Options → File Organizer 
(у Mac: Mendeley → Preferences → File Organizer). 

5. Укладайте бібліографічні списки: 
Якщо у Вас вже є бібліотека документів у Mendeley, то тепер можна з 

легкістю укладати бібліографічні списки у текстових процесорах 
Microsoft Word, чи OpenOffice Writer. Насамперед потрібно встановити 
плагін: пункт меню Tools → Instal Microsoft Word (або OpenOffice) 
Plugin. У Word (OpenOffice) з’явиться панель інструментів Mendeley. 
Вибираємо з випадаючого списку потрібний стиль цитувань, або 
встановлюємо додаткові стилі. 

Для цього, натискаємо у списку More Styles… відкривається форма 
Select Citation Style у якій вибираємо вкладку Get More Styles. Обераємо 
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потрібний стиль і натискаємо Install and Use. Тепер, коли хочете 
процитувати документ, що знаходиться у Вашій бібліотеці Mendeley, 
просто натискаєте на кнопку Insert Citation на панелі інструментів 
Mendeley, знаходите потрібний запис у бібліотеці і натикаєте Ok. 

Якщо Вам зручніше шукати документи для цитування у Mendeley 
Desktop, то можете скористатися кнопкою Go to Mendeley. Оберіть 
потрібний документ і натисніть кнопку Send Citation to MS Word (або 
OpenOffice Writer). 

Обидва варіанти абсолютно рівноправні. Тепер просто створіть 
список бібліографії натиснувши кнопку Insert Bibliography. 

Ви також можете укладати бібліографічні списки і в інших текстових 
редакторах, таких, наприклад, як Google Docs. Просто виберіть документ 
у Mendeley Desktop, натисніть Edit → Copy Citation і скопіюйте цитату в 
документ. Крім цього, ви можете за допомогою миші перетягнути 
документ з Mendeley Desktop у робочий текстовий документ і цитату 
відразу буде додано у вибраному стилі. Ви також можете створити 
бібліографічний список LaTeX-документів. Mendeley Desktop створює 
файл BibTeX для цілої бібліотеки, для групи, окремого документу. 
BibTeX файл(и) оновлюються кожного разу, коли Ви вносите зміни у 
бібліотеці Mendeley Desktop. Ввімкнути підтримку BibTeX можна тут: 
Tools → Options → Bibtex Tab. 

Література: 9. 
 

3. РОЗПОДІЛ БАЛІВ, ЩО ПРИСВОЮЮТЬСЯ СТУДЕНТАМ 
(див. табл.1) 

Можлива кількість балів, набраних до підсумкової форми контролю: 
залік – від 60 до 100 балів. 

Таблиця 1. 
Розділ 1 Розділ 2 Розділ 3 Розділ 4 Сума 

Т.1 Т.2 Т.3 Т.4 
12 32 22 34 

100 

 
Шкала оцінювання: 
90–100 балів – відмінно (А); 
82–89 балів – добре (В); 
74–81 бал – добре (С); 
64–73 бали – задовільно (D); 
60–63 балів – задовільно (Е); 
35–59 балів – незадовільно з можливістю повторного складання (FX); 
1–34 бали – незадовільно з обов’язковим повторним курсом (F). 
 
Розподіл балів за формами контролю:  
 Рубіжне тестування – 6 балів 
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 Звіт про практичну роботу – 4 балів 
 Звіт про самостійну роботу – 2 бал 

 
Методичне забезпечення: 

опорні конспекти лекцій, навчальні посібники, навчально-методичне 
забезпечення дисципліни, інтерактивний комплекс навчально-
методичного забезпечення навчальної дисципліни. 
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6. КОНТРОЛЬНІ ПИТАННЯ З ДИСЦИПЛІНИ 

 
1. Особливості пошукових систем наукової інформації. 
2. Публікативна активність вченого: платформи, інструменти,   
3. Шляхи підвищення індивідуальних наукометричних показників. 
4. Оцінка результатів наукових досліджень на основі публікаційної 

активності. 
5. Персональний веб-портрет вченого: організаційні та технічні 

аспекти формування. 
6. Особливості використання авторських ідентифікаторів. 

http://www.altmetric.com/
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7. Використання соціальних медіа для популяризації 
результатів науково-дослідної роботи. 

8. Поняття блог-квесту та особливості його використання у 
науково-дослідній діяльності. 

9. Створення та координація віртуальних предметних спільнот. 
10. Використання соціальних мереж для дослідників. 
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